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Welcome 
The programmers designed this program to help you, the modern farmer, operate your 
farm efficiently and with greater profitability. The software does the hard work for you, 
so you don’t have to work as hard! 
 

Windows Vista Setup 
 
The program will work with Windows Vista. However, you will need to configure the program 
after it is installed to make it work correctly. This can be accomplished in one of two ways. 
 
The first option is to set the program to run as 
an administrator. 
 

· Right click on the program icon and 
select Properties 

 
· Select the Compatibility tab. 

  
· Check the box to “Run this program as 

an administrator” 
 

· Press OK 
 
Note: When choosing this option, the computer 
will prompt you for permission to run this 
program when you start it. 
 
The second option is to disable user accounts on 
the computer. 
 

· Go to the Control Panel under the Start 
Menu. 

 
· Select “User Accounts” 
 
· Choose the option to “Turn User Control On/Off” 
 
· Click OK and restart the computer 
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Note: Microsoft recommends you keep this new security feature on. Be aware that you are 
removing a level of protection by disabling User Account Control alerts, and you will also be 
disabling Internet Explorer’s “protected mode.” 
 

Registering Your Software 
 
In order to use this software you will need to register it.  Registration is simple with the 
Automatic Online Registration feature. All it takes is a computer connected to the internet and 
just a few clicks of your mouse and the software will register itself automatically. 
 
To use the Automatic Online Registration Feature: 
 

1. Verify your computer is connected to the internet via a broadband or dial-up connection. 
 
2. When you see the registration dialog box, select the first option (Get Registered 

Immediately). 
 

3. A box will appear where you will enter your contact details. 
 

4. Note that you will need to enter the serial number for the hardware that you will be using 
the software with.  Registration cannot be completed without this information. 

 
5. Select Next and a message will appear indicating that the program has successfully 

completed the registration. 
 

Other Registration Options 
 
If you prefer, you can also use one of the other registration options: 
 

�� Complete the Online Form – Select the third option button of the dialog box to obtain 
registration numbers using an online form. After completing the form, you will receive 
the registration numbers in an e-mail message. You can then select the fourth button to 
enter the registration numbers received in the e-mail. 

 
�� Enter Numbers You Previously Received – Select the fourth option button if you have 

already obtained registration numbers from e-mail. Select Next and enter the registration 
numbers in the Registration # boxes. 
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The first time you open the program, it will prompt you for the measurement system you want to 
use. 
 

1. The Measurement System dialog box opens in which you must select either US-
English or Metric (The program will use the measurement system you choose from now 
on). 

 

 
 

2. You can also choose to Show All Units which will display US and Metric units.  When 
the “Show All Units” option is selected, the program will use the first selection (US-
English or Metrics) for area and distance measurements.  However, the program will 
give both US-English and Metrics for any volume measurements. 

 
The program opens a new project so you can begin working in it, or you can select Restore 
Backup on the File menu to restore a backup of a project that you made previously.  For 
instructions on restoring a backup of a project, see the section of this chapter on that topic. 

Backing up Projects 
 
One of the most important things you can do is to make frequent backups of your project using 
the backup feature of the program.  Should something go wrong with your computer, such as a 
catastrophic hardware failure or an infection by a computer virus, you can restore the backup of 
your project in an attempt to recover any lost data.  Without a project backup to restore, there 
might be no way to recover the records and maps for your farm. It is recommended to make 
periodic backups to something other than your hard drive (USB, CD, hard disk, etc) in case of 
failure, loss, or damage. 
 
Use the following instructions to easily make a project backup: 
 

1. Select Backup Project on the File menu in the upper, left-hand corner of the program. 
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2. In the Backup Project dialog box that appears, enter the name you want to give the 
backup in the Backup To box, or replace a backup you made previously by selecting the 
list button  and selecting the backup you want to replace in the list. 

 

 
 

3. The default folder where the program saves your Project backups is the Backup folder, 
which is likely under C:\afviewer folder on your computer’s hard drive.  Use the 
following instructions to save the backup to a different folder (such as your My 
Documents folder) or to a USB or other removable drive: 

 
· In the Backup Project dialog box, select the Browse button. 

 
· In the Save As dialog box that opens, select the folder or removable drive where 

you want to save the backup in the Save In list. 
 

- Or - 
 
Select an icon on the left-hand column of the dialog box and browse to the folder 
or drive where you want to save the backup  (for example, to save the backup to a 
USB drive, select the My Computer icon  and select the drive letter for the 
removable drive to enter it in the Save In box). 
 

· Enter a name for the backup file in the File Name box, or replace a previous 
backup by selecting the backup file in the box above the File Name box. 

 
· Select the Save button to return to the Backup Project dialog box  

 
- Or - 
 
Select Cancel to close the dialog box without saving the backup. 
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4. In the Backup Project dialog box under Options, you can change the size that the 

backup file will be, and the amount of time it will take to create the backup, by selecting 
a different value in the Compression list—choose Maximum (Slowest), Normal, Fast, 
Super Fast, or None.  (Choosing maximum compression will cause the program to take 
the longest time to create the backup but the backup will be a smaller file.  Choosing no 
compression will cause the program to take the shortest time to create the backup but it 
will be a much larger file.) 

 
5. If you are saving the backup to a USB drive or a floppy disk, select Wipe Disk in the 

Disk Prep list if you want to erase all files on the USB drive or floppy disk before 
making the backup.  (Before you select Wipe Disk, be careful to verify there are no files 
you want to keep on the disk or removable drive.) 

 
6. Select OK and the program will show the progress as it saves the backup to the folder, 

removable drive, or floppy disk you chose. 
 

 
 

7. Select Cancel to close the dialog box without making a backup. 
 

8. Repeat the previous steps to save another backup to a different folder, removable drive, 
or floppy disk. 

 

Restoring Project Backups 
 
Should something go wrong with your computer that corrupts the data of your farm project, you 
can attempt to recover the data by restoring a backup of your project. Restoring a project backup 
replaces the information in the current project with the information that you had at the time you 
made the backup.  (For example, if you made a backup of your project on Monday and decide to 
restore the backup on Friday of the same week, you will lose all information entered Tuesday 
through Thursday of that week.) 
 
The program will only restore backups you made with the program.  The program will not 
restore backups made with other backup software, such as the Windows XP Professional backup 
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utility.  For instructions on making a backup of your project, see the previous section of this 
chapter. 
 
To restore a project backup: 
 

1. Select the Restore Backup option on the File menu 
 

2. In the Restore Backup dialog box that appears, select the name of the backup you 
previously made in the Backup Project list. 

 
3. If the backup you made is not in the list, browse to locate it: 

 
· Select the Browse button to open a second Restore Backup dialog box. 

 
· In this Restore Backup dialog box, select the folder or drive where you 

previously saved the backup in the Look In  list. 
 

- Or - 
 
Select an icon on the left-hand column and browse to the folder or removable 
drive where you previously saved the backup (for example, if you saved the 
backup to your My Documents folder, select the My Documents icon  to enter 
it in the Look In  list). 

 
· Select the backup file in the box under the Look In  list to add its name to the File 

Name box. 
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· Select Open to return to the previous Restore Backup dialog box, where the 
program enters the name of the backup in the Restore From box. 

 
- Or - 
 
Select Cancel to close the dialog box without restoring the backup. 
 

 
 

 
 

4. Select OK, and a message asks if you are sure you want to continue with the backup 
process. 

 
5. Select No if you do not want to restore the backup. 

 
6. Select Yes and the program shows the progress as it restores the backup. 

 

 
 

During the restoration of the backup, the program replaces the current data in your project with 
the data in the backup file. When the restoration is complete, you can begin working with the 
restored data. 
 

Changing User Information  
 
The contact information that is printed on many reports comes from the User Information entered 
in the program. 
 
To change the User Information: 
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1. On the File menu, select User Info… 

 
2. In the User Information dialog box, enter the Name, Address, Phone Number, etc that 

you want to show up on printed reports. 
 

3. When finished, press OK. 
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�		
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��	����	� Inputs       
Adding Fields and Inputs 
The program allows you to set up farms, fields and inputs.  This information will be used for 
reports and can be written to your device. Farms and fields are added using the Farm tab, and 
inputs (which are your workers, equipment, and supplies) are set up in the Inputs tab.  The Farm 
and Input tabs are both located in the left-hand column of the program. 
 
Setting up your farms and fields takes very little time.  All you have to do is enter the names of 
your farms, and the names, legal acres and tillable acres for your fields.  If desired, additional 
details can be added for your fields, such as FSA information. 
 
Setting up workers (such as employees) and machines (such as tractors, combines, and sprayers) 
is also easy.  All you are required to enter is certain general information such as names and 
charge units for each item.  If desired, you can add additional data, including addresses and 
license numbers for your workers as well as service intervals for your equipment. 
 
Setting up your supplies requires a little more documentation.  You should enter the correct 
purchase units and distributed units for each supply when first entering them.  For fertilizers, you 
may want to record the appropriate percentages for nitrogen, phosphorus, potassium, or other 
nutrients.  For herbicides, insecticides, and other chemicals, you should decide whether to have 
the program keep detailed chemical records.  If necessary, you can also document protective 
equipment and restricted-reentry requirements. 
 
This chapter explains how to add your farms, fields, workers, machines and supplies to the 
program.  The sections of this chapter follow a logical sequence for setting up your fields and 
inputs, but you can set them up in any order you prefer. 
 

Using the Toolbar 
 

 
 
 

The toolbar has several toolbar buttons for performing many of the tasks of the program:  

  New Farm toolbar button allows you to add new farms to the program. 

   New Field toolbar button lets you add new fields to the program. 



AutoFarm Viewer II Reference Guide 

12 

  New Person toolbar button gives you the ability to add laborers, employees and 
other workers. 

  New Machine toolbar button allows you to add equipment, such as tractors, 
planters and combines. 

   New Supply toolbar button lets you add supplies to your inventory, such as seeds, 
fertilizers and chemicals.  

  Read Job Data toolbar button gives you the ability to import data into the 
program. 

Setting Up Farms 
 
The program allows you to have farms in which to group your fields.  Multiple farms are 
generally used with different landlords, as you can organize your fields by farm name.  Once you 
add your farms to the Farm box, you can begin adding your fields. You can also move fields that 
you previously added to the program to the farm you just created (for instructions on adding your 
fields to the program, see the next section of this chapter).   
 
To add a new farm: 
 

1. Select New Farm on the Resources 
menu. 

 
- Or - 
 
Select the New Farm toolbar button.  

 
 
- Or - 
  

 
Select the <User Info>, right-click the <User Info> icon, and select New Farm on the 
shortcut menu. 
 

2. In the Farm Properties dialog box that appears, enter a name for the farm in the 
Description box. You will not be able to fill in the area boxes here, as these numbers will 
come from the individual fields. 

 
3. In the Notes box, enter any miscellaneous information for the farm (you can enter up to 

255 characters). 
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Now that you have your Farms set up, you will now be able to add Fields under each Farm.  You 
can view and modify a farm’s information by right-clicking its name in the Farm box and 
selecting Farm Properties. 
 
If you find you no longer need a farm, you can either delete or retire the farm.  You cannot delete 
farms for which you have recorded farming operations, but must retire the farm instead.  To 
delete a farm for which you have not entered a farming operation, right-click the farm’s name in 
the Farm box and select Delete.  If you delete all of the jobs associated with a farm (explained 
later in this manual), you will then be able to delete the farm.  To retire a farm for which you 
have entered a farming operation, right-click the farm’s name and select Retire.  When you retire 
a farm, the program will add an asterisk to the farm’s name or remove the field from the Farm 
box.  The program will still keep the retired farm’s farming history in case you need to see it in 
the future. To display/hide retired farms in the Farm box, go to the View menu and select Show 
Retired Land Areas. 
 
 
 

Setting Up Fields 
 
Now that your farms are set up, you can quickly set up your fields so you can begin recording 
farming operations.  All you have to do is enter the field names, tillable and legal acres for your 
fields, and indicate whether you own, cash rent or share crop the fields.  You can also add 
additional information for your fields, including FSA information (optional).  Photographs of 
your field taken with a digital camera, scanned in, etc can also be added to the field information.  
The program allows you to group your fields by farm. Farms may be added to the Farm box, 
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which is in the left-hand column of the program (for instructions on adding farms, see the 
previous section of this chapter). 
 
To add a new field: 
 

1. Select New Field on the Resources 
menu. 
 
- Or - 
 
Select the New Field toolbar button.  

 
 
- Or - 
 

 
 

Select the Farm tab , right-click the icon of the farm  for which you will add 
the field, and select New Field on the shortcut menu.  (If you have not added a farm, 
right-click on the <User Info> and select New Field.  For instructions on adding a farm, 
see the section on that topic in this chapter.) 
 

2. The Field Properties dialog box that appears has tabs you can select to enter field data:.  
 

 
 

 On the General tab page: 
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· Enter a name for the field in the Description box.  This is required information. 
 

· Under Area, enter the number of Legal and Tillable acres. (Tillable acres will be 
used in field records. Mapped acres are calculated automatically from mapped 
boundaries).  Tillable acres are required to be entered. 

 
· Under Owner/Landlord , select the Farm that the field belongs to (You may also 

choose < Farm> if you don’t know or <Add> to add a Farm that is not in the 
list).  

 
· Select whether the field is Owned, Cash Rented, or Share Cropped.  The 

optional landlord information will be used for field records if you upgrade to a 
full field-recording program (such as Farm Trac from Farm Works Software). 

 

3. Select the  tab to enter FSA and Legal information about the field (optional). 
 

· Select the appropriate County where the field resides, or select <Add/Edit>  to 
add a county to the drop down list. Select the Add button in the dialog box, and 
enter the name of the county. 

 
· Under FSA, enter the appropriate information in the FSA Farm #, Field #, Track 

# and Land Class boxes. 
 

· Under Legal, enter the correct information in the Section #, Township # and 
Range # boxes. 

 
· If desired, you may enter a brief description of the field in the Description box 

(you can enter up to 255 characters, spaces and punctuation marks). 
 

· Data entered in the “Info” tab is optional and will be used for field records if you 
upgrade to a full field-recording program (such as Farm Trac from Farm Works 
Software). 

  

4. To add a digital photograph of the field, select the  tab (optional). 
 

· Select the  button. 
 

· In the Change Photo dialog box, select the folder where you previously saved a 
digital photograph of the field (such as the My Pictures folder). 

 
· Select the image file of the digital photograph of the field, and select Open (the 

image file can be a bitmap (.bmp), Joint Photographic Experts Group (.jpg), 
Tagged Image File Format (.tif), or PC Paintbrush (.pcx) file). 
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· The digital photograph of the field appears in the Field Properties dialog box.  

To choose a different photograph, select the  button once 
more. 

 

 
 

· To print the photograph of the field, select the  button. 
 

· To remove the photograph, select the  button (removing the 
photograph from the Field Properties dialog box will not delete the image file 
from your computer’s hard drive or removable drive). 

 
· Photos added in this area will only be used for reference purposes.  They will not 

appear on maps or other areas. 
 

5. When you finish entering the information that you want for the field, select OK.  The 
field name will now appear under the selected Farm in the Farm tab. 

 
View and modify the information for a field any time by right-clicking the field’s name in the 
Farm tab and selecting Properties to open the Field Properties dialog box once again.  In the 
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dialog box you can make the desired changes and select OK to save the changes.  For example, 
you can move a field from the <Farm> farm to a different farm by selecting the name of a farm 
you added in the Farm list. 
 
If you find you no longer need a field, you can either delete or retire the field.  You cannot delete 
a field for which you have recorded farming operations, but must it them instead.  Alternately, 
you can delete the jobs that are under a field and then delete the field.  To delete a field that has 
no jobs, right-click the field’s name in the Farm box and select Delete.  To retire a field for 
which you have entered a farming operation, right-click the field’s name and select Retire.  
When you retire a field, the program will add an asterisk (* ) to the name of a field or remove the 
field from the Farm box.  The program will still keep the retired field’s farming history in case 
you need to see it in the future. To display/hide retired fields in the Farm box, go to the View 
menu and select Show Retired Land Areas. 
 

Setting Up Machinery 
 
It is easy to set up the machinery that you use to perform farming operations, (Combines, 
tractors, planters, sprayers, etc).  You can organize your machines into categories of application, 
baling/forage, farm maintenance, harvesting, hauling/transport, land preparation, other, 
planting/seeding and tractors.  The program can also keep track of detailed information for your 
machines, including when the last service was completed and when the next service is due. 
 
To add a new machine: 
 

1. Select the New Machine toolbar 

button.   
 
- or - 
 

Select the Inputs tab,  right-

click the Machines icon, and 
select New Machine on the shortcut 
menu. 

 

 
 

2. The Machine Properties dialog box that appears has tabs you can select to enter 
information for the machine.  
Under the  tab: 

 
· Enter a name for the machine in the Description box. 
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· Select the type of machine in the Category list (application, baling/forage, farm 
maintenance, harvesting, hauling/transport, land preparation, other, 
planting/seeding or tractors). 

 
· Under Model, enter the make, model, year and serial number for the machine.   

 
· Enter the serial number for the precision ag hardware used with this equipment 

for the Console ID# (this is optional). 
 

· Under Operation, select how you want the machine to be charged (by the acre or 
hour) in the Charge Unit list. Enter the rate per acre or hour in the Charge Rate 
box for the machine.  This information will be used for costing purposes on the 
Job Report. 

 
· Enter the implement width in the Width  box. 

 

 
 

3. To keep track of service records for the machine, select the  tab.  The 
information entered in this box will be used for records if you upgrade to a full field-
recording program (such as Farm Trac from Farm Works Software). 

 
· Select the Service Interval Unit (Acre or Hour). 

 
· In the Current Meter  box, enter the current acres or hours on the machine. 

 
· In the Last Serviced box, enter the acres or hours at the time of the last service. 
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· In the Last Service Date box, enter the date of the last service, or select the 

calendar button  and choose the date in the calendar. 
 

· In the Service Interval box, enter the number of acres or hours to elapse between 
each service (The program automatically calculates and displays the number of 
hours or acres until the next service is due in the Next Service box). 

 
· Enter any Service Notes in the box (you can enter up to 255 characters). 

 

 
 

4. Select the  tab. 
 

· Select the Harvester check box if you will use the machine to perform harvesting 
operations. (Combines, balers, etc.)  If you upgrade to a full field-recording 
program (such as Farm Trac from Farm Works Software), this option will prompt 
the program to request harvest records when the equipment is used in a job. 

 
· Select the Fuelable check box if you want the program to track fuel use for the 

machine.  If a piece of equipment is marked as “Fuelable”, the program will 
include fuel (based on the burn rate) on any jobs where the equipment is used.  
This is used for costing purposes on the Job Report. 

 
· Select Metered to have the program track the hours being logged on the machine. 
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· If the machine uses fuel, select the correct fuel type in the Supply Fuel list. (or 
select <Add> to add a new fuel item to the list)  Enter the Default Burn Rate, 
and select Gal/Acre or Gal/hr. 

 

 
 

5. Add a digital photograph of the machine by selecting the  tab (optional). 
 

· Select the  button. 
 

· In the Change Photo dialog box, select the folder where you previously saved a 
digital photograph of the machine (such as the My Pictures folder). 

 
· Select the image file of the digital photograph, and select Open (the image file 

can be a bit map (.bmp), Joint Photographic Experts Group (.jpg), Tagged Image 
File Format (.tif), or PC Paintbrush (.pcx) file). 

 
· The digital photograph appears in the Machine Properties dialog box.  To choose 

a different photograph, select the  button once again and 
choose a different image file in the Change Photo dialog box. 

 



AutoFarm Viewer II Reference Guide 

21 

 
 

· To print the photograph of the machine, select the  button. 
 

· To remove the photograph, select the  button (removing the 
photograph will not delete the image file from your computer’s hard drive or 
removable drive). 

 
· Photos are used for equipment reports if you upgrade to a field recording program 

(such as Farm Trac from Farm Works Software). 
 

6. When you finish entering the information for the machine, select OK.  The machine now 
appears in the Inputs tab, where you will find it under the appropriate machine category 

 under the Machines icon.  
 
At any time you can open the Machine Properties dialog box so you can view or change the 
machine’s information by right-clicking the name of the machine in the Inputs box and selecting 
Properties on the shortcut menu.  If you find you no longer need a machine, you can delete or 
retire the machine.  You cannot delete a machine you have used in a farming operation, but must 
retire it instead.  Alternately, if you delete the farming jobs (or change them so they no longer 
use this equipment), you will then be able to delete the equipment. 
 
To delete a machine you have not used in a farming operation, right-click the machine’s name in 
the Inputs box and select Delete. 
 



AutoFarm Viewer II Reference Guide 

22 

To retire a machine you have used in a farming operation, right-click the machine’s name and 
select Retire.  When you retire a machine, the program will add an asterisk (* ) to the machine’s 
name or remove its name from the Inputs box.  The program will still keep the farming history 
for the retired machine for future reference. To display/hide retired inputs in the Farm box, go to 
the View menu and select Show Retired Inputs. 
 

Setting Up People 
 
You can use the program to track the operations that your employees or other workers perform.   
 
Before you assign your workers to a job, you must add them to the Inputs box. To add a new 
worker: 
 

1. Select the New Person toolbar 

button.   
 
- Or - 
 

Select the Inputs tab,  right-

click the People icon,  and select 
New Person on the shortcut menu. 

 

 
 

2. The Person Properties dialog box that appears has tabs you can select to enter 

information.   The program 
only requires you to enter a first or last name for the worker on the General tab page; the 
rest of the information is optional. 

 
· Check the Business box to add a name of a business as a contact. 

 
· Select the person’s Title , enter their First, Middle , and Last name, and select the 

appropriate Suffix. 
 

· The Full Name and Sorted Name will automatically fill in. You may change 
these to your preference.  The Sorted Name is how it will show up in all of the 
lists within the program. 

 
· You can also enter the name of the Business for which the person works, and 

their appropriate Job Title. 
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3. Select the  tab to add a mailing address for the person. 
 

· Enter their P.O. box, rural route, or street address in the Street 1 and Street 2 
boxes. 

 
· Enter the person’s City/Town, State/Province, Zip/Postal Code, and Country  in 

the appropriate boxes. 
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4. Select the  tab to enter all relative contact information such as a business 
telephone number, mobile phone number, or e-mail address. 

 

5. Select the  tab to record employee license number and charge rate. 
 

· If the employee has a pesticide applicator’s license, enter the license number here.  
This number will be displayed on the Job Report. 

 
· Enter the Charge Rate in dollars per hour that the employee gets paid.  This 

information will be used for costing purposes on the Job Report. 
 

6. Select the  tab to add a digital photograph of the contact: 
 

· Select the  button. 
 

· In the Change Photo dialog box, select the folder where you previously saved a 
digital photograph of the worker (such as the My Pictures folder). 

 
· Select the image file of the digital photograph, and select Open (the image file 

can be a bit map (.bmp), Joint Photographic Experts Group (.jpg), Tagged Image 
File Format (.tif), or PC Paintbrush (.pcx) file). 
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· The digital photo appears in the Person Properties dialog box.  To change the 

photograph of the worker, select the  button to open the 
Change Photo dialog box once again. 

 
· To print the worker’s photograph, select Print Photo. 

 
· To remove the photograph, select Remove Photo (removing the photograph will 

not delete the image file from your computer’s hard drive or removable drive). 
 

7. When you finish entering the information for the worker, select OK (the worker now 
appears in the Inputs box under the People icon).   

 
You can later open the Person Properties dialog box to review or change the worker’s 
information by right-clicking the worker’s name in the Inputs box and selecting Properties.  If a 
person is no longer an employee, you can delete or retire the worker.  You cannot delete a 
worker who you used in a job, but must retire the worker instead.  Alternately, if you delete the 
operation(s) (or change them so the person is not included) that the person was used in, you will 
then be able to delete the person.  To delete a worker you have not used in a farming operation, 
right-click the worker’s name in the Inputs box and select Delete. 
 
To retire a worker you have used in a farming operation, right-click the worker’s name and select 
Retire.  When you retire a worker, the program will add an asterisk to the worker’s name, or 
remove the name from the Inputs box.  The program will keep the work history for the retired 
worker for future reference.  To display/hide retired employees in the Farm box, go to the View 
menu and select Show Retired Inputs. 
 

Setting Up Supplies 
 
The program allows you to keep comprehensive information for all of the supplies you apply to 
your fields such as seeds, fertilizers, insecticides, and other chemicals.  You can record detailed 
chemical information and re-entry restrictions for applicable chemicals and document the 
analysis of nitrogen, phosphorus, potassium and other nutrients for your fertilizers. 
 
Before you can add a supply to a farming operation, you must add the supplies to the Inputs box. 
To add a new supply: 
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1. Select the New Supply toolbar 

button.   
 
- or - 
 

Select the Inputs tab,  right-
click the Supplies icon,  and select 
New Supply on the shortcut menu. 

 

 

 
2. The Supply Properties dialog box opens and has the following tabs to record 

information for the supply: 
 

  Under the  tab: 
 

· Enter a name for the supply in the Description box. 
 

· If relevant, enter the Part # for the supply. 
 

· Under Type, select the supply category (choose Herbicide, Insecticide, 
Fungicide, Nematicide, Rodenticide, Seed, Fertilizer/Lime , Adjuvant , 
Growth Regulator, Other Chemical, Feed, Fuel, or Other Non-Distributed 
Item). 

 
· Enter the Purchased Units, Unit Cost, Distributed Unit, and the Default 

Application Rate.  The program will automatically fill in the conversion value.  
The Purchased Unit is the unit of measure that you wish to use to track the total 
quantity of product used.  The Distributed Unit is the unit of measure that the 
product is applied at.  The Unit Cost is the cost that you will purchase the supply 
for.  This information will be used for costing purposes on the Job Report. 

 

3. To keep detailed chemical records for the supply, select the  tab and select 
the  Keep Detailed Chemical Records  option. 

 
· Enter all of the applicable information about the supply.  This information should 

be taken from the label on the chemical.  The information will be used for further 
reporting if you upgrade to a full crop recording software (such as Farm Trac 
from Farm Works Software). 
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· Add target problems in the Target Problems box by selecting the Add/Edit 
Problem List button, which opens the Pest Selection dialog box. 
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· In the Pest Selection dialog box, select the pests controlled by the chemical in the 
Pests box (select more than one by holding down the Ctrl key as you click them 

with your mouse), and then select the  button to add them to the 
Selected Pests box. A maximum of 5 pests can be selected. Many times, a broad 
term such as “Broadleaves” or “Grasses” can be used to narrow the list. 

 
· To remove pests from the Selected Pests box, select them in the box and select 

the  button, or select  to remove all. 
 

· If you need to add a new pest to the Pest Selection dialog box, select Add/Edit  to 
open the Pests dialog box, select the Add button, and enter the name of the new 
pest. 

 

4. If the supply you add is a fertilizer, select the Fertilizer tab  and complete 
the following: 
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· In the Fertilizer Nutrients  box, select the first nutrient and the percent of the 
analysis that nutrient makes up in the Percent % column. The picture below 
shows an example of liquid 10-34-0. 

 
· Select the Add Nutrient  button to add a row to the Fertilizer Nutrients  box. 

 
· In the new row, enter the second nutrient in the Nutrient  column and the 

percentage of that nutrient in the Percent % column. 
 

 
 

· Repeat the previous steps to add as many nutrients as needed. 
 

· If a nutrient is not in the drop down list, select <Add/Edit>  to add it to the list. 
 

· Remove a nutrient from the analysis by selecting the remove button  to the left 
of the row for that nutrient. 

 
· The program will enter the product weight conversion factor in the Product 

Weight for you. 
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· Fertilizer information will be used for detailed fertilizer reporting if you upgrade 
to a full crop-recording program (such as Farm Trac from Farm Works Software). 

 

5. Select the  tab if you need to record re-entry restrictions for the supply. 
Re-entry Restrictions should be taken directly from the label. 

 
· Select the Re-entry Restrictions check box and enter the required number of 

hours in the Restricted-Entry Interval  box. 
 

 
 

· In the PPE Required for Handlers and Early Entry PPE Required for 
Workers boxes, enter the required protective equipment for those handling the 
supply. 

 
· In the Other Label Requirements box, enter the other requirements for those 

handling the supply. 
 
If applicable, select the Treat Area Posting and Oral Notification Required check box. 
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· Information entered in this area will be used for detailed chemical reporting if you 

upgrade to a full crop-recording program (such as Farm Trac from Farm Works 
Software). 

 
6. When you have all of the desired information recorded for the supply, select OK (the 

supply will now appear in the Inputs box, under the appropriate Supply type—for 
example, a new fertilizer will appear under the Fertilizer/Lime  icon).  

 
View or modify the information for a supply at any time by right-clicking the name of the supply 
in the Inputs box and selecting Properties on the shortcut menu.  If you find you no longer need a 
supply, you can delete or retire it.  You cannot delete a supply that you used in a farming 
operation—instead you must retire it.  Alternately, if you remove the jobs (or change them so 
they do not include the supply) where the supply was used, you can then delete the supply.  To 
delete a supply you have not used in a farming operation, right-click the supply’s name in the 
Inputs box and select Delete.  To retire a supply you have used in a farming operation, right-click 
the supply’s name and select Retire.  When you retire a supply, the program will add an asterisk 
(* ) to its name, or remove the supply from the Inputs box.  The program will still keep the retired 
supply’s farming history for future reference.  To display/hide retired employees in the Farm 
box, go to the View menu and select Show Retired Inputs. 
 

Adding/Editing Commodities 
 
Commodities that are used in the program have properties tied to them that can be edited. The 
program has a long list of pre-entered commodities that can be chosen from. Commodities must 
be added to show up in lists as active. These changes are made under Commodity Properties. 
 
To edit Commodity Properties: 
 

1. Under the Resources menu, select Commodities… 
 

2. The commodities that are currently being used will be displayed in the Commodities box 
that appears. 

 

3. To add a commodity, press the  button and select the new commodity from 
the list or select <New> to add your own. 

 

4. To edit a commodities’ information, press the  button. 
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5. After adding a new commodity name or when viewing the properties, the Commodities 
Properties box appears. Here you can enter/change any information about the commodity. 

 

 
 

· Units are the harvested units of the commodity 
 

· Density and moisture are used to calculate dry quantities when harvesting. 
Moisture should be the moisture that dry weight is calculated from. This 
information can be received from your local elevator or wherever you deliver 
your grain. 

 
· The Units, Density and Moisture information entered in this area will be used for 

yield mapping and detailed harvest records (including scale tickets) if you 
upgrade to a full crop recording and mapping program (such as Farm Trac and 
Farm Site from Farm Works Software). 

 
· The value of the commodity is what will be used on reports. 
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· The Color will be the color shown on the map where that commodity is being 

grown. 
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Importing and Viewing Jobs 
Jobs can be imported from company devices that record job and map data. The program will 
allow you to view these maps, add inputs to the jobs, and print job reports. It will also allow you 
to export these jobs in several formats.  When reading job data, the program will read (and create 
maps and field records) for any data that is available.  This can include a job coverage map, field 
boundaries and guidance paths. 
 

Importing Jobs 
 
You will first need to have the job data on a removable device, such as a USB thumb drive or 
removable card. Insert the drive or card into the computer and it is always a good idea to copy 
the data to your hard drive as a backup. You can then read the data from either the card or your 
hard drive. 
 
To import an operation: 
 

1. Select Read Job Data on the File 
menu. 

 
- Or - 
 
Select the Read Job Data button on 
the Job/Resource Tools toolbar.  

 

 
2. You will have to browse for the path to find the files. When you browse, make sure you 

select a .zip file for an ATC job or a .sqlite file for an A5 job or the FarmPro .rbin file. 
 
3. Select the job(s) to be imported and press OK. 
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4. If the job being imported is in a Field that has not been created or the spelling is different, 
the Linker dialog box will appear.  

a. The “Skip confirming farm/field information” check box in the lower right of the 
Read Job Data page is checked by Default 

i.   
1. The program assumes the imported detailed information about 

Farm, Field, Supplies and Operator has been completed.  So 
therefore does not require confirmation of the imported data. 

ii.  
1. Requires confirmation of the imported detailed information about 

Farm, Field, Supplies, and Operator. 
 

 
 

5. Here, you have the option of creating a new Field or linking the new one with one already 
created. Once linked, all jobs with that field name in the future will be linked to the field 
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selected.  To link a field, select the name of the field (as it was created on the field 
device) from the “Operation Resources” on the left.  Then select the field that you created 
in the software (as explained earlier in this manual) from the “Desktop Resources” on the 
right.  Click on the “Link” button and the data will be linked to the appropriate field. 

 
6. If you select Create, you will have to fill out the Farm and Field properties if they are 

new. Notice the program automatically fills in the names based on what was collected on 
the unit. Add any additional information as necessary.  Additionally, if the data includes a 
boundary for the field, the program will fill in the size of the field. 
 

 
 

7. When finished linking all new fields, press OK. 
 
8. The job(s) has been imported into the program and will be displayed in the Farm tab as 

well as the Job tab. 
 

Viewing Jobs on the Map Tab 
 
Once you have imported jobs into the program, you can view coverage data and field boundaries 
on the map tab. You can also view the information tied to those maps on the information tab at 
the bottom of the map screen. 
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Using the Map Toolbar 
 
When you select the Map tab, the Map toolbar will be displayed. 
 

 
 
The Map toolbar has toolbar buttons for changing the views of maps of your fields: 

 Select Tool allows you to select objects in the Map tab. This can be used to select 
items in a rectangle, circle, or polygon by clicking the down arrow. Invert 
Selection is useful if you want to reverse the items that are selected on the map.  
You can view information on the selected item by going to the “Information” tab 
at the bottom of the screen. 

 

 Measure Tool enables you to measure objects in the map tab. Click where you 
want to start measuring and click again to start another segment. Total length and 
distance in the X and Y directions are displayed in the bottom right corner of the 
screen. The X and Y values are only of the last segment. Right click to stop 
measuring. 

  

 

 Pan Tool allows you to click and drag the map to view objects not on the screen.  
The arrow keys on the keyboard can also be used to scroll up and down and to the 
left or right on a map. 
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 Zoom Tool lets you zoom in or out. Left click to zoom in and 
right click to zoom out. The map will center where you click. 
You can also click and drag to zoom into a specifically sized 
area.  

 

 Zoom In zooms closer without re-centering the map.  The “I” key on the 
keyboard can also be used to zoom in. 

 Zoom Out zooms out without re-centering the map.  The “O” key on the 
keyboard can also be used to zoom out. 

 Zoom Layer zooms the active layer into view. 

 Zoom All zooms to the extent of all displayed layers on the map.  The “A” key on 
the keyboard can also be used to zoom all.  

 Display Options lets you change the Point Size for job maps and the color of 
boundaries and points (for field boundaries and coverage maps). 

 Map Report allows you to print the currently displayed map. 
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There are several ways of viewing job maps. You can locate the job in the Farm tab tree and 
double click on it to display the job in the map tab. You can also go to the Job tab (either at the 
top of the screen or at the bottom of the Map tab) and put a check in the View column.  The view 
column will be bold or highlighted if the Job has not yet been viewed as map data. 
 

 
 

 
 
Depending on the type of job displayed and the data collected, there will be different data 
associated with the map. Select the layers tab at the bottom of the map tab screen and you will 
notice the Views area. You can highlight the views to display the different data associated with 
the job. The legend will automatically update as you select each view. 
 
The Views area will also display a legend for the map that is based off the data attribute that you 
select.  At the top of the Views area is a “Markers” button.  This option can be used to assign a 
symbol to any marker/flag data that was logged.  Points with the appropriate flags will have the 
selected symbol on top of the point. 
 
Guidance Points – The “Markers” button can be used to assign a symbol to any logged guidance 
points.  When this option is used, guidance points can easily be identified on the Map tab. 
 
To remove the job from the map screen, simply go to the Job tab and uncheck the box under the 
View column. 
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You can view data associated with the map by selecting an item(s) on the map and going to the 
information tab. If multiple items are selected, it will show the average, minimum and maximum 
values. 
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Modifying and Managing Jobs 
After you import jobs (farming operations), it is easy to manage and modify the jobs.  You can 

manage jobs in either the Farm tab  or the Jobs tab.   To locate a job in the 
Farm box all you have to do is select the Farm tab and open the tree and select the appropriate 
farm and field to view a job that has been recorded. To find a job in the Jobs box, select the Jobs 
tab and use the sorting and filtering features to display only the jobs that meet the criteria of the 
job for which you are searching. 
 
Once you locate a job, you can modify the operation by right-clicking it and selecting Properties 
on the shortcut menu. This opens the Job Properties dialog box where you can change any of the 
details of the farming operation.  Use the Job Properties box to change the dates of the farming 
operation, the number of acres farmed, and even the field in which the operation took place. 
Right-clicking the job and selecting Delete on the shortcut menu can also delete jobs. 
 

Using the Jobs Tab 
 

When you select the  tab, all of the jobs you have imported into the program will be 
listed. The Jobs tab has a separate row for each job. There are several columns, including the Job 
Name, Date, Field, Year, Commodity, Type, Operator and other columns, under which you will 
see the specific information for each job.  These column headers can sort jobs. 
 
To find a specific job in the Jobs box: 
 

1. Select the  tab to see all jobs. 
 

2. The Box indicating the job will be highlighted if that job has not yet been viewed as map 

data.  To sort the jobs listed, select a column header of the Jobs box.  
For example, select the Field column header to sort the jobs by field name, or select the 
Date column header to sort the jobs by date and display the most recent jobs first. 

 
3. To reverse the order of the jobs, select a column header a second time (for example, 

select the Date column header a second time to display the oldest jobs first). 
 

4. To widen or narrow a column, move your cursor over the space between the column 
header you want to widen or narrow so that the cursor changes to one with two arrows.  

  Hold the left mouse button down as you drag your mouse to the left or right to adjust 
the column width. 
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5. If it is difficult to find the job you are looking for because the Jobs box is cluttered, use 
the filter button to display only certain jobs. To view the jobs for only one farm or field: 

 

· Select the Farm tab.  
 

· Select the plus sign  next to the icon of the farm  for the jobs you want to 
display. (The program highlights the farm and displays the fields of that farm in 
the Farm box). 

 
· Select the Filter Jobs by Farm check box at the top of the Farm tab to display 

only the jobs for that farm in the Jobs tab. 
 

· Select a specific field icon  in the Farm box, and the program shows only the 
operations for that field in the Jobs tab. 

 
· To remove the filter, clear the Filter Jobs by Farm check box, and the program 

displays all of the jobs for all of the fields in the Jobs box once again. 
 

6. You can filter jobs by a specific Machine, Person, or Supply by doing the same thing in 
the Inputs tab. 

 

7. To filter jobs by a date range, or by other criteria, select the  button at the 
bottom of the Jobs box to open the Job Filter  dialog box. Select the check boxes for 
each property you want to add to the filter. Jobs can be filtered by more than one 
criterion. 

 
· To filter jobs by a particular date range, select the Date Range check box and 

enter the desired dates in the From and To boxes. 
 

· To filter jobs by any of the other criteria, select the check boxes beside the 
property and enter or select the values to filter. 

 
· To remove criteria from the job filter, clear their check boxes. 

 
· Apply the job filter by selecting OK, and the Jobs box now displays only the jobs 

that meet the criteria of the filter you created. 
 

· Edit the items filtered by selecting the  button again and follow the 
previous steps. 

 

· Remove the filter by selecting the  button, and the program will 
display all jobs in the Jobs box once again. 
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· It is possible to apply a filter that doesn’t show any jobs in the list. If the job list is 

ever blank, just press the  button to show all of the jobs again. 

8. Other tasks can be performed with the buttons at the bottom of the Jobs box: 

  

Right clicking on a job in the jobs list can also perform each of these tasks. 

· Select the  button to print job reports for a highlighted job. See the 
printing section of this manual for more information. 

· The  button allows you to export an .xml file, a shape file, a .csv file, 
or a Datalog File. 

· Use the  button to delete a job. Once removed, a job cannot be 
recovered. 

· The  button allows you to view or edit the details of a job. 

 

Using the View Menu 
 

Use the View menu of the program to set your viewing preferences for the Farm  and 

Input  boxes.  The View menu allows you to show or hide items in the Farm box, such as 
retired land areas.  Items in the Inputs box can also be hidden, such as retired machines, people, 
or supplies. 
 
To show or hide items in the Farm and Inputs boxes: 
 

1. Checkmarks beside items in the View menu indicate which items are displayed and 
which are hidden. 
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2. To show retired inputs, select the Inputs tab  and select Show Retired Inputs on 
the View menu. The program places a checkmark beside the menu item and displays the 
retired inputs with an asterisk (*) beside them. To hide the retired inputs again, simply 
remove the checkmark beside Show Retired Inputs. 

 
3. To put an input back into use and out of retirement, place a checkmark beside Show 

Retired Inputs on the View menu, right click the retired input, and select Un-Retire on 
the shortcut menu. This will remove the asterisk from the input’s name. 

 

 

4. To show retired farms and fields, select the Farm tab  and select Show Retired 
Land Areas on the View menu. The program places a checkmark beside the menu item 
and displays the retired land areas with an asterisk (*) beside them. To hide the retired 
land areas again, simply remove the checkmark beside Show Retired Land Areas. 

 
5. To put a farm or field back into use and out of retirement, place a checkmark beside 

Show Retired Land Areas on the View menu, right click the retired farm or field, and 
select Un-Retire on the shortcut menu. This will remove the asterisk from the farm or 
field’s name. 

Editing Jobs 
 
You can edit a farming operation at any time. First, find the job tab. You can then modify the job 
by viewing the Job Properties.  
 
To edit a farming operation: 
 

1. Find the farming operation under either the  tab or the  tab. Filters and 
sorting can be used to assist in finding the jobs (see Using the Jobs Tab section). 

 
2. Right click on the farming operation you want to modify and select Job Properties on 

the shortcut menu. Under the Jobs tab, you can also select the  button after 
highlighting the job. 
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3. The Job Properties box will appear for the operation. Here you can make any 

modifications needed. 
 

 
You can also change the Field Name, Crop Enterprise, Job Type, and any other 
information displayed in the Job Properties dialog box.  
 
· Farming operations can be modified as often as needed.

 

Removing/Deleting Jobs 
 
At any time you can delete farming operations. Deleting farming operations permanently 
removes them from the program. 
 
To delete a farming operation: 
 

1. Find the farming operation under either the  tab or the  tab. Filters and 
sorting can be used to assist in finding the jobs (see Using the Jobs Tab section). 

 
2. Verify the operation is the one that needs removed by right clicking on the job and 

selecting Properties on the shortcut menu. This will display all of the entered 
information about the operation. 
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3. Once it is determined the operation needs deleted, right click on the Job name and select 
Delete. You can also highlight the job name under the Jobs tab and press the 

 button at the bottom of the screen. 
 

4. Several operations can be removed at one time by holding the Ctrl key and selecting each 

operation under the  tab.  Alternately you may click on the first job to be 
selected and hold down the Shift key on your keyboard and click on the last job.  The 
program will select the two jobs along with all jobs that are listed in between. Once they 

are all highlighted, press the  button at the bottom of the screen. 
 

5. Once a job is deleted, the records are PERMANENTLY removed from the program.  A 
deleted job can only be recovered by restoring a backup or re-importing the raw data. 

 

Exporting Jobs 
 
You can export jobs from the program and save them on your computer or removable media 
such as a USB drive.  The file formats in which you can save the exported jobs include Comma 
Separated Value (.csv), FODM (.xml), and ArcView Shape (.shp, .shx and .dbf) and DataLog 
(*.txt) files. Jobs that you export will remain unchanged in the Jobs box.  This makes it possible 
to take the job data to another field recording and/or mapping program.  Note that if you wish to 
use the data with a program from Farm Works Software (such as Farm Trac and Site), you can 
make a backup of your project (explained earlier in this manual), which will include all of your 
data, and restore that to Farm Trac and Site. 
 
After exporting jobs, you can import them into another compatible program. Comma Separated 
Value (.csv) files can be exported and opened with a spreadsheet program, such as Microsoft 
Excel. The details of the job can then be viewed, emailed, or printed. 
 
To export an operation: 
 

1. Locate and select the farming operation under the  tab. Filters and sorting can 
be used to assist in finding the correct operation (see Using the Jobs Tab section). 

 
2. Verify the operation is the one that needs to be exported by right clicking on the job and 

selecting Properties on the shortcut menu. This will display all of the entered 
information about the operation. 

 
3. To export the job, right-click on it in the Jobs box and select Export  on the shortcut 

menu or select the  button at the bottom of the screen. 
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4. The Job Export dialog box will then open. 
 

· Select the location to save the operation to. (My Documents, a USB Drive, etc.) 
 

· Enter a name for the job in the File Name box. 
 

· Select the type of file to export the job to in the Save as Type list. (choose 
ArcView Shape File (*.shp), Comma Separated Values File (*.csv), DataLog 
(*.txt) or FODM XML File (*.xml)  as the file type) 

 
· Select Save to complete the export. 

 
The program saves the exported job to the folder or removable drive chosen.  You can use 
Windows Explorer or My Computer to locate the file to copy it to a removable drive, attach it to 
an e-mail, or import it into another program. To open a Comma Separated Value file with your 
computer’s spreadsheet program, (such as Microsoft Excel) right-click the file, point to Open 
With on the shortcut menu, and select the program to use to view the file. 
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Printing and Saving Reports 
Job reports are printed from the Jobs tab and contain all of the information entered about the job. 
The following formats can be used when saving a job report: Microsoft Word documents, 
Microsoft Excel spreadsheets, and Adobe Acrobat Reader Portable Document Format (PDF) 
documents. 
 

Printing and Saving Job Reports 
 
The job report is a summary of the details of the farming operation that has been completed.  
Multiple jobs may be printed, however each job will be displayed on a separate page. 
 
To print or save a job report: 

1. Locate and select the farming operation(s) under the  tab. Filters and sorting 
can be used to assist in finding the correct operation (see Using the Jobs Tab section).  
Multiple jobs may be selected using the Ctrl or Shift keys on your keyboard. 

 
2. Right-click the job in the Jobs box, and select Print  on the shortcut menu or highlight the 

job and select the  button at the bottom of the screen. 
 

3. A print preview screen will open where you can print or export the job report. 
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4. To choose a printer to which to print the report, or change the printer properties, select 
the Printer Setup toolbar button.  

 

 
 

5. Select the Print  button  on the toolbar at the top of the window to print the report. 
 



AutoFarm Viewer II Reference Guide 

50 

6. In the Print  dialog box that appears, you can choose the pages and number of copies to 
print. 

 
7. To save a copy of the report: 

 
· Select the Export  toolbar button.   

 
· In the Export  dialog box that appears, choose the type of file you want to save the 

report as. 
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· In the Export Options dialog box, select the pages of the report to export or press 
OK to export the whole report. 

 

 
 

· In the Choose Export File dialog box, select the folder or removable drive where 
you want to save the report and enter a name for the file in the File Name box. 

 
· The program will then export the report to the specified location where it can be 

printed, copied, or emailed.
 

Printing and Saving Map Reports 
 

When you are in the Map tab, you can select the Map Report  button to print the map as it is 
displayed. When the Map Report button is selected, the program will give you a preview of the 
map report on the screen.  The Map Report will include basic summary information for any job 
that is displayed (including the Farm, Field, Crop, Job Name, Area, Start Date and Time, End 
Date and Time, and Job Hours).  Additionally, the map report will include the legend that was 
used in the Map tab.  Select the “Print” button at the top of the report preview to print the map to 
a printer. 
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